
Genere marcos de datos como tablas
usando kable(data, caption).

```{r}
data <- faithful[1:4, ]
knitr::kable(data, 

           caption = "Table with kable")
```

Otros paquetes de tablas incluyen flextable, gt y 
kableExtra.

Establezca las opciones para todo el documento en el 
primer fragmento.

```{r include=FALSE}
knitr::opts_chunk$set(message = FALSE)
```

Rodea los fragmentos de código con '''{r} y ''' o usa el 
botón Insertar fragmento de código          . Agregue 
una etiqueta de fragmento y/o opciones de fragmento 
dentro de las llaves después de r.

```{r chunk-label, include=FALSE}
summary(mtcars)
```
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Cree citas a partir de un archivo de bibliografía, una 
biblioteca de Zotero o referencias DOI. 

CONSTRUYE TU BIBLIOGRAFÍA

• Agregue bibliografías BibTeX o CSL al encabezado 
YAML.
---
title: "My Document"
bibliography: references.bib
link-citations: TRUE
---

• Si Zotero se instala localmente, su biblioteca principal 
estará disponible automáticamente. 

• Agregue citas por DOI buscando "from DOI" en el 
cuadro de diálogo Insertar cita.

INSERTAR CITAS

• Para acceder al cuadro de diálogo Insertar citas en el 
Editor visual, haga clic en el símbolo @ de la barra 
de herramientas o haga clic en Insert > Citation. 

• Agregar citas con sintaxis de markdown escribiendo 
[@cite] o @cite.

Publicar en

rpubs.com,

shinyapps.io, 

Posit Connect

Volver a cargar 
el documento

buscar en el documento

ruta de acceso del archivo al 
documento de salida

¿Qué es rmarkdown?

Flujo de trabajo
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3. Escribe 
texto

2. Código de 
insertado

Inserte 'r <code>' en las secciones de texto. El código 
se evalúa en la representación y los resultados 
aparecen como texto.

"Built with `r getRversion()`" --> "Built with 4.1.0"

Incrustar código con knitr

CÓDIGO EN LÍNEA

ESTABLECER OPCIONES GLOBALES

FRAGMENTOS DE CÓDIGO

Archivos .Rmd · Desarrolle su código 
e ideas en paralelo en un solo 
documento. Ejecute código como 
fragmentos individuales o como un 
documento completo.

Documentos Dinámicos · Entreteje 
gráficos, tablas y resultados con texto 
narrativo. Renderiza en una variedad de 
formatos como HTML, PDF, MS Word o 
MS Powerpoint.

Investigación Reproducible · Cargue, 
vincule o adjunte su informe para 
compartirlo. Cualquiera puede leer o 
ejecutar su código para reproducir su 
trabajo.

Insertar citas

Agregar/editar 
atributosEDITOR VISUAL Insertar citas

Insertar tablas

La sintaxis de la izquierda se representa como la salida 
de la derecha.

OPCIÓN PREDETERMINADO EFECTOS

echo TRUE mostrar código en el documento de salida

error FALSE
TRUE (mostrar mensajes de error en el documento)
FALSE (detener renderizado si se produce error)

eval TRUE ejecutar código en fragmento

include TRUE include chunk en doc después de ejecutar

message TRUE mostrar mensajes de código en el documento

warning TRUE mostrar advertencias de código en el documento

results "markup"
"asis" (resultados de la transferencia)
"hide" (no mostrar resultados)
"hold" (coloca los resultados debajo del código)

fig.align "default" "left", "right", o "center"

fig.alt NULL texto alternativo para una figura

fig.cap NULL leyenda de la figura como una cadena de texto

fig.path "figure/" prefijo para generar rutas de archivo de figura

fig.width & 
fig.height

7 dimensiones de la gráfica en pulgadas

out.width Reescala el ancho de salida, p. ej. "75%", "300px"

collapse FALSE Contraer todas las fuentes y salidas en un solo bloque

comment "##" prefijo para cada línea de resultados

child NULL archivo(s) para tejer y luego incluir

purl TRUE
incluir o excluir un fragmento de código al extraer
código fuente con knitr::purl()

Para ver más opciones y valores predeterminados, ejecute str(knitr::opts_chunk$get())

6. Compartir

Texto sin formato.

Termine una línea con dos espacios 
para comenzar un nuevo párrafo.

También termina con una barra 
invertida\ para hacer una nueva línea.

*cursivas* y **negritas**

superíndice 2̂ /̂subíndice~2~

~~tachado~~

escapado: \* \_ \\

endash: --, emdash: ---

# Encabezado 1

## Encabezado 2

...

###### Encabezado 6

- lista desordenada
- artículo 2
   - artículo 2a (sangrar 1 tab)
   - artículo 2b

1. lista ordenada
2. artículo 2
   - artículo 2a (sangrar 1 tab)
   - artículo 2b

<enlace URL>

[Este es un enlace.](enlace URL)

[Este es otro enlace][id].

   At the end of the document:
      [id]: link url

![Caption](image.png)
or ![Caption][id2]

   At the end of the document:
      [id2]: image.png 

`verbatim code`

```
multiple lines
of verbatim code
```

> block quotes

equation: $e {̂i \pi} + 1 = 0$

equation block: 
$$E = mc {̂2}$$

horizontal rule:
---

| Right | Left | Default | Center |

|-------:|:------|-----------|:---------:| 

| 12 | 12 | 12 | 12 | 

| 123 | 123 | 123 | 123 | 

| 1 | 1 | 1 | 1 |

    HTML Tabsets
   ## Results {.tabset}
    ### Plots
    text

    ### Tables
    more text

1. Abra un nuevo archivo .Rmd en el IDE de 
RStudio yendo a File > New File > R Markdown.

2. Incrustar código en fragmentos. Ejecute código 
por línea, por fragmento o todo a la vez.

3. Escribe texto y añade tablas, figuras, imágenes y 
citas. Formatee con la sintaxis de Markdown o el 
editor visual de Markdown de RStudio.

4. Establezca los formatos y las opciones de salida 
en el encabezado YAML. Personaliza temas o 
añade parámetros para ejecutar o añade 
interactividad con Shiny.

5. Guarde y procese todo el documento. Teje 
periódicamente para obtener una vista previa de 
tu trabajo mientras escribes.

6. ¡Comparte tu trabajo!

5. Guardar y 
renderizar

EDITOR DE CÓDIGO FUENTE

SALIDA RENDERIZADA

1. Nuevo 
archivo

Opciones de estilo

1

2

3

4

5

6

4. Establecer formato(s) 
y opciones de salida

Texto sin formato.

Termine una línea con dos espacios 
para comenzar un nuevo párrafo.

También termina con una barra 
invertida\ para hacer una nueva línea.

cursivas y negritas

superíndice2/subíndice2

tachado

escapado: * _ \

endash: –, emdash: —

Encabezado 1
Encabezado 2
...

Encabezado 6

• lista desordenada
• artículo 2

• artículo 2a (sangrar 1 tab)
• artículo 2b

1. lista ordenada
2. artículo 2

• artículo 2a (sangrar 1 tab)
• artículo 2b

http://www.posit.co/

Este es un enlace.

Este es otro enlace.

Caption.

 verbatim code

   multiple lines
 of verbatim code

      block quotes

equation:  𝑒𝑖𝜋 + 1 = 0

equation block: 

𝐸 = 𝑚𝑐2

horizontal rule:

Results

    Plots       Tables

  text

Right Left Default Center
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FORMATO DE SALIDA CREA

html_document .html

pdf_document* .pdf

word_document Microsoft Word (.docx)

powerpoint_presentation Microsoft Powerpoint (.pptx)

odt_document OpenDocument Text

rtf_document Rich Text Format

md_document Markdown

github_document Markdown para Github

ioslides_presentation ioslides HTML slides

slidy_presentation Slidy HTML slides

beamer_presentation* Beamer slides

* Requires LaTeX, use tinytex::install_tinytex()

Also see flexdashboard, bookdown, distill, y blogdown.

Establecer formatos de salida y sus opciones en YAML

Más opciones de encabezado

Al renderizar un documento,

rmarkdown:

1. Ejecuta el código e incrusta

los resultados y el texto en un archivo .md con

knitr. 

2. Converts the .md file into the output format with 

Pandoc.

OPCIONES IMPORTANTES DESCRIPCIÓN

anchor_sections Mostrar anclajes de sección al pasar el ratón por encima (TRUE o FALSE) X

citation_package El paquete LaTeX para procesar citas ("default", "natbib", "biblatex") X

code_download Ofrezca a los lectores la opción de descargar el archivo código fuente de Rmd (TRUE o FALSE) X

code_folding Permitir que los lectores alternen la visualización del código R ("none", "hide", o "show") X

css Archivo CSS o SCSS que se utilizará para aplicar estilo al documento (e.j. "style.css") X

dev Dispositivo gráfico que se utilizará para la salida de figuras (p. ej. "png", "pdf") X X

df_print Método para imprimir marcos de datos ("default", "kable", "tibble", "paged") X X X X

fig_caption ¿Deben las figuras representarse con leyendas? (TRUE o FALSE) X X X X

highlight Resaltado de sintaxis("tango", "pygments", "kate", "zenburn", "textmate") X X X

includes Archivo de contenido para colocar en el documento ("in_header", "before_body", "after_body") X X

keep_md Guarde el archivo .md de Markdown generado al tejer (TRUE o FALSE) X X X X

keep_tex Conserva el archivo TEX intermedio utilizado para convertir a PDF (TRUE o FALSE) X

latex_engine Motor LaTeX para producir salida PDF ("pdflatex", "xelatex", o "lualatex") X

reference_docx/_doc docx/pptx que contiene los estilos que se van a copiar en la salida (p. ej. "file.docx", "file.pptx") X X

theme Opciones de tema (consulte Bootswatch y Temas personalizados a continuación) X

toc Agregar una tabla de contenido al principio del documento(TRUE o FALSE) X X X X

toc_depth El nivel más bajo de encabezados para agregar a la tabla de contenido (por ejemplo, 2, 3) X X X X

toc_float
Hacer flotar la tabla de contenido a la izquierda del contenido del documento principal(TRUE o 

FALSE)
X

Use ?<output format> para ver todas las opciones de un formato, p. ej. ?html_document
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Parametrice sus documentos para reutilizarlos 
con nuevas entradas (p. ej., datos, valores, etc.).

1. Agregue parámetros 
en el encabezado 
como subvalores de 
parámetros.

2. Llamada 
parámetros en el 
código 
params$<name>.

3. Establezca los 
parámetros con Knit
with Parameters o 
el argumento 
params de render().

Convierta su informe en un documento Shiny
interactivo en 4 pasos:

1. Añade runtime: shiny al encabezado YAML.

2. Llame a las funciones de entrada Shiny para 
incrustar objetos de entrada.

3. Llame a las funciones de renderizado Shiny
para incrustar la salida reactiva.

4. Renderice con rmarkdown::run() o de click
en Run Document en RStudio IDE.

---
output: html_document
runtime: shiny
---

```{r, echo = FALSE}
numericInput("n",   
  "How many cars?", 5)

renderTable({
  head(cars, input$n)
})
```

Publicar en Posit Connect 
para compartir documentos de

R Markdown de forma segura,

programar actualizaciones 
automáticas e interactuar con parámetros en 

tiempo real. 

posit.co/products/enterprise/connect.

Guarda, y, a continuación, Knit para obtener una vista previa 
de la salida del documento. El documento HTML/PDF/MS 
Word/etc. resultante se creará y guardará en el mismo 
directorio que el archivo . Archivo Rmd.

Use rmarkdown::render() para renderizar/tejer en la 
consola de R. Vea ?render para conocer las opciones 
disponibles.

Renderizar

Compartir

Use el encabezado YAML del documento para 
establecer un formato de salida y personalizarlo 
con opciones de salida.

Personalice los documentos HTML con temas de 
Bootswatch del paquete bslib utilizando la opción 
de salida del tema.

Utilice bslib::bootswatch_themes() para listar los 
temas disponibles.

Más sobre bslib en pkgs.rstudio.com/bslib/. 

TEMAS DE BOOTSWATCH ESTILO CON CSS Y SCSS

Agregue CSS y SCSS a su documento 
agregando una ruta a un archivo con la opción 
css en el encabezado YAML.

---
title: "Document Title"
author: "Author Name"
output:
  html_document:
    theme:
      bootswatch: solar
---

---
title: "My Document"
author: "Author Name"
output:
  html_document:
    css: "style.css"
---

---
title: "My Document"
author: "Author Name"
output:
  html_document:
    toc: TRUE
---

PARÁMETROS

---
params: 
  state: "hawaii"
---

```{r}
data <- df[, params$state]
summary(data)
```

INTERACTIVIDAD

TEMAS PERSONALIZADOS

Personalice elementos HTML individuales 
utilizando variables bslib. Utilice ?bs_theme para 
ver más variables.

Aplique el estilo CSS escribiendo etiquetas HTML 
directamente o:
• Utilice markdown para aplicar atributos de estilo 

en línea.

Intervalo entre corchetes
A [green]{.my-color} word. 

Div
::: {.my-color}
All of these words 
are green.
:::

• Utiliza el editor visual. Vete a Format > 
Div/Span y agregue estilo CSS directamente 
con Editar atributos.

---
output:
  html_document:
    theme:
      bg: "#121212"
      fg: "#E4E4E4"
      base_font:
        google: "Prompt"
---

Consulte también Prerenderizado variocolor para 
obtener un mejor rendimiento. 
rmarkdown.rstudio.com/authoring_shiny_prere
ndered.

Inserte una aplicación completa en su documento 
con shiny::shinyAppDir(). Más en 
bookdown.org/yihui/rmarkdown/shiny-
embedded.html. 

PLANTILLAS REUTILIZABLES
1. Cree un nuevo paquete con un directorio 

inst/rmarkdown/templates.
2. Agregue una carpeta que contenga 

template.yaml (abajo) y esqueleto. Rmd
(contenido de la plantilla).
---
name: "My Template"
---

3. Instale el paquete para acceder a la plantilla 
yendo a
File > New R Markdown > From Template. Este es un div con algo de texto.

... .my-css-tag

A green word. 

All of these words 
are green.

Formato de sangría 2 
caracteres, opciones de 

sangría 4 caracteres

.Rmd .md
HTML

PDF

DOC

knitr pandoc
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